Notice

While reasonable efforts have been made to ensure that the information in this document is complete and accurate at the time of printing, Avaya assumes no liability for any errors. Avaya reserves the right to make changes and corrections to the information in this document without the obligation to notify any person or organization of such changes.

Documentation disclaimer

“Documentation” means information published in varying mediums which may include product information, operating instructions and performance specifications that are generally made available to users of products. Documentation does not include marketing materials. Avaya shall not be responsible for any modifications, additions, or deletions to the original published version of Documentation unless such modifications, additions, or deletions were performed by or on the express behalf of Avaya. End User agrees to indemnify and hold harmless Avaya, Avaya’s agents, servants and employees against all claims, lawsuits, demands and judgments arising out of, or in connection with, subsequent modifications, additions or deletions to this documentation, to the extent made by End User.

Link disclaimer

Avaya is not responsible for the contents or reliability of any linked websites referenced within this site or Documentation provided by Avaya. Avaya is not responsible for the accuracy of any information, statement or content provided on these sites and does not necessarily endorse the products, services, or information described or offered within them. Avaya does not guarantee that these links will work all the time and has no control over the availability of the linked pages.

Warranty

Avaya provides a limited warranty on Avaya hardware and software. Refer to your sales agreement to establish the terms of the limited warranty. In addition, Avaya’s standard warranty language, as well as information regarding support for this product while under warranty is available to Avaya customers and other parties through the Avaya Support website: https://support.avaya.com/helpcenter/getGenericDetails?detailId=C20091120112456651010 under the link “Warranty & Product Lifecycle” or such successor site as designated by Avaya. Please note that if You acquired the product(s) from an authorized Avaya Channel Partner outside of the United States and Canada, the warranty is provided to You by said Avaya Channel Partner and not by Avaya.

“Hosted Service” means an Avaya hosted service subscription that You acquire from either Avaya or an authorized Avaya Channel Partner (as applicable) and which is described further in Hosted SAS documentation or other materials available to You. “Software” means the software that was acquired by or on behalf of You and the entity for whom You are installing, downloading or using the Software (hereinafter referred to interchangeably as “You” and “End User”), agree to these terms and conditions and create a binding contract between You and Avaya. Avaya grants You a license within the scope of the license types described below, with the exception of Heritage Nortel Software, for which the scope of the license is detailed below. Where the order documentation does not expressly identify a license type, the applicable license will be a Designated System License as set forth below in the Designated System(s) License (DS) section as applicable. The applicable number of licenses and units of capacity for which the license is granted will be one (1), unless a different number of licenses or units of capacity is specified in the documentation or other materials available to You. “Software” means computer programs in object code, provided by Avaya or an Avaya Channel Partner, whether as stand-alone products, pre-installed on hardware products, and any upgrades, updates, patches, bug fixes, or modified versions thereto. “Designated Processor” means a single stand-alone computing device. “Server” means a set of Designated Processors that hosts (physically or virtually) a software application to be accessed by multiple users. “Instance” means a single copy of the Software executing at a particular time: (i) on one physical machine; or (ii) on one deployed software virtual machine ("VM") or similar deployment.

License types

Named User License (NU). You may: (i) install and use each copy or Instance of the Software on a single Designated Processor or Server per authorized Named User (defined below); or (ii) install and use each copy or Instance of the Software on a Server so long as only authorized Named Users access and use the Software. “Named User”, means a user or device that has been expressly authorized by Avaya to access and use the Software. At Avaya’s sole discretion, a “Named User” may be, without limitation, designated by name, corporate function (e.g., webmaster or helpdesk), IP address, e-mail or voice mail account in the name of a person or corporate function, or a directory entry in the administrative database utilized by the Software that permits one user to interface with the Software.

Heritage Nortel Software

“Heritage Nortel Software” means the software that was acquired by Avaya as part of its purchase of the Nortel Enterprise Solutions Business in December 2009. The Heritage Nortel Software is the software contained within the list of Heritage Nortel Products located at https://support.avaya.com/LicenseInfo under the link “Heritage Nortel Products” or such successor site as designated by Avaya. For Heritage Nortel Software, Avaya grants a Customer a license to use the Heritage Nortel Software provided hereunder solely to the extent of the authorized activation or authorized usage level, solely for the purpose specified in the Documentation, and solely as embedded in, for execution on, or for communication with Avaya equipment.

You do not wish to accept these terms of use, you must not access or use the hosted service or authorize anyone to access or use the hosted service.

Licenses

The software license terms available on the Avaya website, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO, under the link “Avaya software license terms (Avaya Products)” or such successor site as designated by Avaya, are applicable to anyone who downloads, uses and/or installs Avaya Software, purchased from Avaya Inc., any Avaya Affiliate, or an Avaya Channel Partner (as applicable) under a commercial agreement with Avaya or an Avaya Channel Partner. Unless otherwise agreed to by Avaya in writing, Avaya does not extend this license if the Software was obtained from anyone other than Avaya, an Avaya Affiliate or an Avaya Channel Partner. Avaya reserves the right to take legal action against you and anyone else using or selling the Software without a license. By installing, downloading or using the Software, or authorizing others to do so, you on behalf of yourself and the entity for whom you are installing, downloading or using the Software (hereinafter referred to interchangeably as “you” and “end user”), agree to these terms and conditions and create a binding contract between you and Avaya. The applicable Avaya affiliate (“Avaya”),

Copyright 2009-2017, Avaya Inc. All Rights Reserved.
Charges for Heritage Nortel Software may be based on extent of activation or use authorized as specified in an order or invoice.

Copyright
Except where expressly stated otherwise, no use should be made of materials on this site, the Documentation, Software, Hosted Service, or hardware and software provided by Avaya. All content and software contained on this site, the Documentation, Hosted Service, and the product provided by Avaya including the selection, arrangement and design of the content is owned either by Avaya or its licensors and is protected by copyright and other intellectual property laws including the sui generis rights relating to the protection of databases. You may not modify, copy, reproduce, republish, upload, post, transmit or distribute in any way any content, in whole or in part, including any code and software unless expressly authorized by Avaya. Unauthorized reproduction, transmission, dissemination, storage, and or use without the express written consent of Avaya can be a criminal, as well as a civil offense under the applicable law.

Virtualization
The following applies if the product is deployed on a virtual machine. Each product has its own ordering code and license types. Note, unless otherwise stated, that each instance of a product must be separately licensed and ordered. For example, if the end user customer or Avaya Channel Partner would like to install two instances of the same type of products, then two products of that type must be ordered.

Third Party Components
"Third Party Components" mean certain software programs or portions thereof included in the Software or Hosted Service may contain software (including open source software) distributed under third party agreements ("Third Party Components"), which contain terms regarding the rights to use certain portions of the Software ("Third Party Terms"). As required, information regarding distributed Linux OS source code (for those products that have distributed Linux OS source code) and identifying the copyright holders of the Third Party Components and the Third Party Terms that apply is available in the products, Documentation or on Avaya’s website at: https://support.avaya.com/ Copyright or such successor site as designated by Avaya. The open source software license terms provided as Third Party Terms are consistent with the license rights granted in these Software License Terms, and may contain additional rights benefiting You, such as modification and distribution of the open source software. The Third Party Terms shall take precedence over these Software License Terms, solely with respect to the applicable Third Party Components to the extent that these Software License Terms impose greater restrictions on You than the applicable Third Party Terms.

The following applies only if the H.264 (AVC) codec is distributed with the product. THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE REMUNERATION TO: (I) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD ("AVC VIDEO") AND/OR (II) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM.

WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL PARTNER IS HOSTING ANY PRODUCTS THAT USE OR EMBED THE G.729 CODEC, H.264 CODEC, OR H.265 CODEC, THE AVAYA CHANNEL PARTNER ACKNOWLEDGES AND AGREES THE AVAYA CHANNEL PARTNER IS RESPONSIBLE FOR ANY AND ALL RELATED FEES AND/OR ROYALTIES. THE G.729 CODEC IS LICENSED BY SIPRO LAB TELECOM INC. SEE WWW.SIPRO.COM/CONTACT.HTML. THE H.264 (AVC) CODEC IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE REMUNERATION TO: (I) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD ("AVC VIDEO") AND/OR (II) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION FOR H.264 (AVC) AND H.265 (HEVC) CODECS MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM.

Compliance with Laws
You acknowledge and agree that it is Your responsibility for complying with any applicable laws and regulations, including, but not limited to laws and regulations related to call recording, data privacy, intellectual property, trade secret, fraud, and music performance rights, in the country or territory where the Avaya product is used.

Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications system by an unauthorized party (for example, a person who is not a corporate employee, agent, subcontractor, or is not working on your company’s behalf). Be aware that there can be a risk of Toll Fraud associated with your system and that, if Toll Fraud occurs, it can result in substantial additional charges for your telecommunications services.

Avaya Toll Fraud intervention
If you suspect that you are being victimized by Toll Fraud and you need technical assistance or support, call Technical Service Center Toll Fraud Intervention Hotline at +1-800-643-2353 for the United States and Canada. For additional support telephone numbers, see the Avaya Support website: https://support.avaya.com or such successor site as designated by Avaya.

Security Vulnerabilities
Information about Avaya’s security support policies can be found in the Security Policies and Support section of https://support.avaya.com/security.

Suspected Avaya product security vulnerabilities are handled per the Avaya Product Security Support Flow (https://support.avaya.com/css/P8/documents/100161515).

Downloading Documentation
For the most current versions of Documentation, see the Avaya Support website: https://support.avaya.com, or such successor site as designated by Avaya.

Contact Avaya Support
See the Avaya Support website: https://support.avaya.com for product or Hosted Service notices and articles, or to report a problem with your Avaya product or Hosted Service. For a list of support telephone numbers and contact addresses, go to the Avaya Support website: https://support.avaya.com (or such successor site as designated by Avaya), scroll to the bottom of the page, and select Contact Avaya Support.

Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this site, including but not limited to Microsoft software or codecs, the Avaya Channel Partner is required to independently obtain any applicable license agreements, at the Avaya Channel Partner’s expense, directly from the applicable third party supplier.

Service Provider
THE FOLLOWING APPLIES TO AVAYA CHANNEL PARTNER’S HOSTING OF AVAYA PRODUCTS OR SERVICES. THE PRODUCT OR HOSTED SERVICE MAY USE THIRD PARTY COMPONENTS SUBJECT TO THIRD PARTY TERMS AND REQUIRE A SERVICE PROVIDER TO BE INDEPENDENTLY LICENSED DIRECTLY FROM THE THIRD PARTY SUPPLIER. AN AVAYA CHANNEL PARTNER’S HOSTING OF AVAYA PRODUCTS MUST BE AUTHORIZED IN WRITING BY AVAYA AND IF THOSE HOSTED PRODUCTS USE OR EMBED CERTAIN THIRD PARTY SOFTWARE, INCLUDING BUT NOT LIMITED TO MICROSOFT SOFTWARE OR CODECS, THE AVAYA CHANNEL PARTNER IS REQUIRED TO INDEPENDENTLY OBTAIN ANY APPLICABLE LICENSE AGREEMENTS, AT THE AVAYA CHANNEL PARTNER’S EXPENSE, DIRECTLY FROM THE APPLICABLE THIRD PARTY SUPPLIER.
or otherwise, any license or right in and to the Marks without the express written permission of Avaya or the applicable third party.

Avaya is a registered trademark of Avaya Inc.

AVAYA

All non-Avaya trademarks are the property of their respective owners. Linux® is the registered trademark of Linus Torvalds in the U.S. and other countries.

Java is a registered trademark of Oracle and/or its affiliates.
Contents

Chapter 1: New in this release................................................................. 6
  Features........................................................................................................ 6
  Document changes since last issue........................................................ 6
  Other changes.......................................................................................... 6

Chapter 2: Introduction........................................................................... 8

Chapter 3: Application Programming Interface fundamentals.............. 9
  Open Provisioning Interface fundamentals........................................... 9
  Accessing the OPI Java documentation.................................................. 10
  SOAPUI...................................................................................................... 10

Chapter 4: XML Configurator................................................................. 11
  Creating custom configuration files....................................................... 11
  Uploading custom configuration files.................................................... 12
  Exporting data....................................................................................... 13
Chapter 1: New in this release

The following sections detail what's new for Avaya Aura® Application Server 5300 Application Programming Interfaces, NN42040-110 for Avaya Aura® Application Server 5300 Release 4.0.

Features

The following feature-related changes were made:

• XML Configurator is new in this release, and provides functionality to bulk import and export data on Provisioning Servers. This allows administrators to easily provision multiple subscribers or routes, or export data about multiple subscribers or routes.

For information on the new features in this release, see Avaya Aura® Application Server 5300 Release Delta, NN42040-201.

Document changes since last issue

The following changes have been made to this document since the last issue:

• Added a new chapter describing XML Configurator, see XML Configurator on page 11.

Other changes

Revision history

<table>
<thead>
<tr>
<th>November 2017</th>
<th>Updated the legal page for Application Server 5300 Release 3.0.</th>
</tr>
</thead>
<tbody>
<tr>
<td>November 2012</td>
<td>Draft 05.01.AB This document is issued to support Avaya Aura® Application Server 5300 Release 4.0. Added the following:</td>
</tr>
<tr>
<td></td>
<td>• A new section Document changes since last issue on page 6.</td>
</tr>
<tr>
<td></td>
<td>• A new chapter XML Configurator on page 11.</td>
</tr>
</tbody>
</table>

Comments on this document? infodev@avaya.com
<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>August 2012</td>
<td>Draft 05.01.AA. This document is issued to support Avaya Aura® Application Server 5300 Release 4.0.</td>
</tr>
<tr>
<td>June 2012</td>
<td>Draft 04.01. This document is issued to support Application Server 5300 Release 3.0. Removed Bulk Provisioning Tool (BPT) content, including several chapters.</td>
</tr>
<tr>
<td>September 2010</td>
<td>Standard 03.01. This document is issued to support Application Server 5300 Release 3.0.</td>
</tr>
<tr>
<td>April 2010</td>
<td>Standard 02.01. This document is issued to support Application Server 5300 Release 2.0.</td>
</tr>
<tr>
<td>June 2008</td>
<td>Standard 01.01. This document is new for Nortel Application Server 5300 Release 1.0.</td>
</tr>
</tbody>
</table>
Chapter 2: Introduction

This document discusses the Avaya Aura® Application Server 5300 Open Provisioning Interface (OPI) Application Programming Interface (API) available to third party clients for provisioning and administering the system from a remote workstation.

Navigation

• Application Programming Interface fundamentals on page 9
• SOAPUI on page 10
• Accessing the OPI Java documentation on page 10
Chapter 3: Application Programming Interface fundamentals

The Application Server 5300 provides Application Programming Interface (API) support for third-party client applications through the Open Provisioning Interface (OPI).

⚠️ Important:

The Bulk Provisioning Tool (BPT) is deprecated as of Application Server 5300 Release 2.0. Existing BPT scripts work for services available in Application Server 5300 Release 1.0, but for new functions and enhancements to existing functions, you must update any existing scripts.

Navigation

- Open Provisioning Interface fundamentals on page 9

Open Provisioning Interface fundamentals

The Open Provisioning Interface (OPI) is used to remotely provision the Application Server 5300 system. OPI is based on the Simple Object Access Protocol (SOAP) 1.1 and the emerging web services standard. OPI supports the industry standard Web Services Description Language (WSDL) 1.1., which allows the service provider to provision their system with existing and custom applications. The goal of OPI is to allow customer-specific applications to interface with the Application Server 5300 provisioning system.

Information about OPI is provided in Java docs. The Java docs contain an overview of the OPI specification with procedures for using OPI, and listings of OPI WebService methods. For information about accessing the OPI Java docs, see Accessing the OPI Java documentation on page 10.

For information on the error codes returned from OPI commands, see Avaya Aura® Application Server 5300 Troubleshooting and Fault Management, NN42040-700.
Accessing the OPI Java documentation

About this task

This procedure describes how to access the Open Provisioning Interface (OPI) Java documentation. These Java documents represent the various categories of OPI web services available. Each OPI web service category contains a description of the OPI web service in general, and descriptions of each associated provisioning operation (OPI provisioning method) and bean objects.

In addition to the web services descriptions, the Java documents include an overview that provides a summary listing of all the web services and general information and procedures for using OPI. A help document is also included that describes how the Java documents are organized.

Procedure

1. Download the OPISpec.zip file from the Avaya Aura® Application Server 5300 software download portal.
2. Unzip the OPISpec.zip file to your local drive.
   The unzip operation creates a folder named OPISpec containing folders and files.
   The Java document for the Help opens in the browser. The Help describes how the OPI Java documents are organized and provides a link to the Overview and a listing of all the Web service Java documents.

SOAPUI

A Simple Object Access Protocol (SOAP) client tool is required for Open Provisioning Interface (OPI) Java development. Avaya recommends SOAPUI, a free and open source desktop application for

- inspecting Web Services
- invoking Web Services
- developing Web Services
- Web Services simulation and mocking
- functional, load and compliance testing of Web Service

SOAPUI is designed for developers and testers of Web Services (including Java and.net). For more information about SOAPUI, go to http://www.soapui.org.
Chapter 4: XML Configurator

This chapter describes the XML Configurator tool, which you can use to:

• provision multiple subscribers or multiple routes by loading an XML file corresponding to the OPI specification.
• export data from the Provisioning server.

Navigation

• Creating custom configuration files on page 11
• Uploading custom configuration files on page 12
• Exporting data on page 13

Related links

Creating custom configuration files on page 11
Uploading custom configuration files on page 12
Exporting data on page 13

Creating custom configuration files

Before you begin

• You have Microsoft Excel 2010.

About this task

Use this procedure to create custom configuration files that you can upload to the Provisioning server to provision one or more subscribers or routes. The configuration file must have a three-part XML structure that corresponds to the OPI specification.

This procedure shows you how to create the file using a template in Microsoft Excel, which is effective for most purposes. Advanced users can optionally create custom configuration files using a programming language. For more information about advanced methods, see the Methods of Procedure.

Procedure

1. Log in to the Provisioning Client.
2. Click Tools > XML Configurator to open the XML Configurator portlet.
3. Click Download template, and choose a location on your local PC to save the file.
4. On your local PC, extract the contents of the file (`ProvConfigTemplate.zip`).

   The files extracted include xml templates for various uses, and a readme.txt file, which contains additional information about how to use the templates in XML Configurator.

5. Launch Microsoft Excel.

6. If the Developer tab is not visible, click **File > Options > Customize Ribbon.** Select the **Developer** check box, and click **OK**.

7. Click the **Developer** tab.

8. Click **Source** to open the XML Source Panel.

9. Click **XML Maps** to open the XML Maps window.

10. On the XML Maps window, click **Add**.

11. Browse to the folder where you extracted `ProvConfigTemplate.zip`, select an xml template file, and click **OK**. If a schema message box appears, click **OK**. Click **OK**.

   The XML Sources panel is now populated with elements.

12. Populate the template by dragging elements into cells on the sheet. Optionally, add comments in unused cells. (Comments do not appear in the exported xml file.)

13. On the **Table Tools** tab, click **Refresh** to import data from the template.

14. In the XML Source panel, click **Verify Map for Export** to verify that your configuration is OPI compliant.

15. To export the file to XML, click **Developer > Export**, enter the file name `CustomConfig.xml`, and click **Export**.

---

**Related links**

- [XML Configurator](#) on page 11

---

**Uploading custom configuration files**

**Before you begin**

- You have created a custom configuration file called `CustomConfig.xml`. See [Creating custom configuration files](#) on page 11.

- You can access the Provisioning Client using an account that has administrator privileges on the domain to which the custom configuration applies.

- If you have exported a configuration from one system, and are importing it into another, you have edited the file to reflect the domain configuration of the system to which you are importing the file.

**About this task**

Use this procedure to upload a custom configuration file to a Provisioning server.
Exporting data

About this task

Use this procedure to export data from the Provisioning server to an XML file.

Procedure

1. Log in to the Provisioning Client.
2. Select User > Search.
3. On the Advanced Search tab, select the subscribers for which to export data, and click Export.
4. Type a name for the xml file to export, and click Save.

Next steps

You can optionally modify the exported file, and upload the modified file to the Provisioning server. For more information about editing and uploading XML files, see Creating custom configuration files on page 11 and Uploading custom configuration files on page 12.

Note that the order of XML elements in the file is crucial. Exercise caution if editing the configuration file manually.

Related links

XML Configurator on page 11